EE]
EE[

=

= Sl

PREEERRREEEE o lnlakalE@iad " [ ERAZRABRERERE
B o ipipininini ..aa...aa.a%

AARRARAARAAA ] 5 = (1 AARAAAARRAAP

FADS

- Laboratorium —

Elektronikai Technolégia szakirany BSC

Laborvezetd: Bolvari Zsolt
(bolvari.zsolt@gmail.com)



mailto:(bolvari.zsolt@gmail.com)

Kezdetek...

Aramkor kivalasztasa

— Tapfeszultsegek

— Aramfelvétel

— HOmérséklet-tartomanyok

— Pontossag igénye(!)
Megvalosithatosag vizsgalata
Elvi kapcsolasi rajz osszeallitasa
Szimulaciod, korrekcid

Panel tervezése

Gyartasba valo leadas

Minden lépés hatassal van az 0sszes tobbi lépésre!

Fontos szem el6tt tartani: a tervezeés barmit megenged, a gyartas mar
nem...

Modularamkorok és készulékek 2



CAD rendszerek

CAD (Computer Aided Design)
azaz
Szamitogeppel segitett tervezes

Feladata a tervezd segitése
Minden mérnoki teruleten megjelent

» Adott feladatkorhoz (elektronika, épitGipar, vegyészet...) optimalizalt

Modularamkorok és készulékek



FObb CAD rendszerek az
aramkortervezesben

orcad

a Cadence product family

Altlum

Making Elec

Modularamkorok és készulékek 4



Mentor-féle tervezés folyamata

PADS
Cresign Flow

System Design Physical Design

- Schematic capture - PCB layout
- Warlants and reuse - Imteractive routing
- FPGA Integration - Auto routing
« Manufacturing prép

Analysis & Verification

- Analag slmulatian - HOL simulation
- Mined A/D simulation - Signal integrity analysis

O Menior Geaphics

Modularamkorok és készulékek



F6 PADS komponensek

LOGIC
*Elvi kapcsolasi rajz tervez6
*Kapcsolas O0sszeallitasa

*Dokumentacio generalas

PADS' Logic

*Alkatrész tervezés

LAYOUT
‘NYAK-tervezd

*Hordozo tervezés

*Footprint tervezés f
P Atjarhatosag: NETLIST-an

*Dokumentacio generalas keresztul

Modularamkorok és készulékek 6



Tervezendd aramkor

DC-DC konverter tervezése
Cél: teljes tervezési folyamat bemutatasa egyszerl aramkoron keresztul
Bemenet: kapcsolasi rajz
Kimenet: gyartas
— leadhat6 Gerber file-ok
— Jegyz6konyv
» Leadandod: gyakorlat befejeztét kovetd 1 héten beldl
+ Elvarasok
— Kapcsolas mikodése: vazlatosan, funkcionalis szempontbdl
— Elvi kapcsolasi rajz
— Szimulacids eredmények: szimulator program és szamitasok
— NYAK-terv: elrendezés-rajz, Layout-rajz, beiiltetési rajz
+ Tartalmazza:
Hallgaté neve, E-MAIL-cime, NEPTUN kodja
Laborvezet6 neve, E-MAIL cime

Laborfoglalkozas datuma, idépontja
Labor célja, helye (V2201-es labor, datum)

Modularamkorok és készulékek



Elvi kapcsolasi rajz
szerkesztese

Jps EatEyavat

|I'_|_,,

Modularamkorok és készulékek



Elvi kapcsolasi rajz
szerkesztese

DSES| il AR o QES S8 e I ED
S =B il S B I M S D P =t ¥
e XE BREDE Y OEYBES

Untitled - PADS Logic

==l x|

o
= o
) WelcometerPADS L ogic
%_"
o
@
9‘ Tasks
. e
\_) ] Start a new design
N Open a design
D:/Dokumentumok/.../Kapcsolasok/AVR design board SCH
D:/Dokumentumok/Melo/RS232 cloner/Kapcsolasok/1F/rs232cin_1F
C:/DOCUME~1/.../Shuntb Point to an
D:/Dokumentumok/Melo/RS232 cloner/Kapcsolasok/rs232cin_1e A
item for a
description.
% Getting Started g Help Click the item
) ( \ to open it.
Q_}) PADS Design Flow “A,.) Q_}) PADS Logic Help P
»,
+ . Search PADS SupportNet on the Support and
"' QuickStart Training tab of the InfoHub
Find the Tutorial List on the Support and
% Training tab of the InfoHub
, Tip: Te show it en startup again, click
I Don't show Welcome on startup Help > Show Welcome screen on startup
Menlor
Graphics:
Ready [ |[width 10 ||Grid 100 ||o000. 000/ o000, 0oo|

Modularamkorok es keszulekek



Elvi kapcsolasi rajz szerkesztese

Y Untitled - PADS Logic

==l
File Edit Wiew Setup Tools  Help
D HS [ sheet 1 =1 | PPl Q & 5 E B
B e = EiE] NN R EE )| [ |
N & x| @ P B 0o tr 7t | @0 % @Al File -> Libary
=l

-

3
Width 10 ||Grid 100 13100 10500

Ready

Modularamkorok és készulékek 10



Elvi kapcsolasi rajz szerkesztese

RT=TEY
Library
[&ll Libraries]
Create NeW le - Create Mew Lib... I ki anage Lib. List. .. I Auttr b anager. .. I

— Eilter
3 Decal= 'ﬁ: Part:z

£ | Lines =+~ | Logic

Ix

Filenév, utaljon a munka nevére,
SCH véggel (jeloli, hogy elvi

Szimbolumokat tartalmaz) ApEly
— ltems=

e,
Edit.... |
Delete |

Mentés ——» Bezar —
Minden felhasznalt szimbdlumot mpet . | Esper | ListtoFie |
ide kell menteni!!! Még azokat B e |

P

is, melyek mas konyvtarakban
megtalalhatok!!!  Modularamkérdk és késziilékek



Elvi kapcsolasi rajz szerkesztese

L] Untitled* - PADS Logic =l=x]
=== = she
% | @B oSl  Global Desin | Tewt | Linewidths |
&+ & K BPEDC Gridz Parameters
§ Desian 100 Tie Dot Diameter: |25
E Bus Angle Offzet: |5EI7 -
= I T =2
Labels and Text: |10 [+ Preserve Fef Des on Paste e e
[v Snap to Grid [v llow Floating Connections TOOlS > Optlons

; Tip: Be gure to choose a sheet border that fitz
Sige: |24 j' withir the boundarnies of the selected sheet size.

Sheet border. | SIZEAd | Choose.. |

[ Show Dff-page Sheet Mumbers

Separators; |[_ |]_ Mumbers per Line: |0

Maon ECO Regiztered Parts Maon Electrical Parts
[ Include in Metlist [ Inchude in Metlist
[ Include in ECO ta PCE [ Include in ECO ta PCB
| Include in BOM Report I+ Include in BOM Report
| k. | Cancel | Help |
[
Ready “Width 10 |)Grid 100 S000 GE00

Modularamkorok és készulékek 12



Elvi kapcsolasi rajz szerkesztese

L] untitled*® - PADS Logic =S|
File Edit Wew Setup Tools Help

=== | sheet1 jf} QA | e E E
Dxl b & % e | g % B0 e | tr o gt | ¢ Ii?\@’&

S AN 1 S gl Tl e [ 1] 3 P

=l

Jadod g poalol4

= A4/<]Drawing NumberRelvision>

Ready Width 10 ||Grid 100 1500 7900

Modularamkorok és készulékek 13



Elvi kapcsolasi rajz szerkesztese

File -> Library->Manage lib. List ->Add...

Egyenként hozzaadni a rendszerhez a
konyvtarakat. Igy az 0sszes szimbolum
elerheto lesz.

Modularamkorok és készulékek
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Elvi kapcsolasi rajz szerkesztese

L] untitled*® - PADS Logic mEES|

P & X

Jadod g poalol4

Ready

File Edit Wew Setup Tools Help

O HE

i sheet 1 o QA B e EE
Bt A e EYEML
% o% | [0 I [Heodra £ o 0+ [us] [ 2]as] ]

™ add Part from Library =100 x|

COM_USE_B

Items:
zajat_footpint_padz: COM_USE_B i‘ Add
zajat_footprint_padzQUARTS_3 PIMS \_I
zajat_footprint_padz: TUSKESOR-Z41_DRL:
s zajat_footprint_pads TUSKESOR-242 100 Cloze
MO DECAL zajat_footprint_padz TUSKESOR_-Z<2_ 100 4

zajat_SCHEMATIC_padsz50SG100
zajat_SCHEMATIC pads:ACCEL_SEMSOR ﬂ

Alkatrész kivalasztasa.
Kivalaszthatd a konkrét
konyvtar is.

Ha megvan: Add

=
E Filker
Library:

& | |40 Libraries) R

* _ b |
* E

[temms:

Modularam EartName:




Elvi kapcsolasi rajz szerkesztese

C3

D1

D2

D3

Q1, Q2, Q4
Q3 '
L1

2
2
1
1
1
1
C1,C2 2
1
1
1
1
3
1
1
MISC 1

Description Substitutions
22K 1/4W Resistor ™
4 TK 1/4W Resistor
1K 1/4W Resistor
| - RES ¥4 W

1.5K 1/4W Resistor
33K 1/4W Resistor

10K 1/4W Resistor .
0.1TuF Ceramic Disc Capacitor ———* CAPO0603

470uF 25V Electrolytic Capcitor CAPAE4

1N914 Diode } _

1N4004 Diode Misc:DIODE

12V 400mW Zener Diode —» BZX79C12

BC547 NPN Transistor » Motor-tx:BC547
» Motor-tx:BD679

BDG679 NPN Transistor

See Notes » Misc:IND-UPRIGHT
Heatsink For Q3, Binding Posts (For Input/Output), Wire, Board

Modularamkorok és készulékek
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Elvi kapcsolasi rajz szerkesztese

T
G
MEG
K

Prefixumok

tera 1012
giga 1079
mega 100
kilo 1073
milli 103
micro 106
nano 10-°
pico 10712
femto 1015
(0.001") 25.4-10 ©

Modularamkorok és készulékek
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Elvi kapcsolasi rajz szerkesztese

L1
[ND-UPRIGHT

Item YWizibility

[v Reference Designator

[ Part Type
[ Pin Mumbers

Iv Fin Mames

Attribute Mame Dizplay
£ Al D

{* Mo Change
" AllOn

Apply Update ta

{* This Gate

{ " This Part

" All Parts This Tupe

o]

Beallitani!!!

Attributes

D escription
Marnufacturer #1
Fart Mumber
FCE DECAL
Sim.Analog Model
Sim.Analog. Order
Sim.Analog, Prefis
Tolerance

W alue

Cancel

Help

Modularamkorok és készulékek

18




Modularamkorok és készulékek 19



Y| Part: RES-1/4W* - PADS Logic
File Edit Wew Setup Tools Help

a8 Q@ BE

Jguojdxg josloag

szerkesztdbal R

L wFree Lobel 10T

 [paostosic
?r/ Update all parts of Part Type RES-1j4w
gy minden
ellenallast frissit az pa———.
uj kepre S

Ready Width 10 ||Grid 10 3450 -1340

Modularamkorok és készulékek 20



Elvi kapcsolasi rajz szerkesztese

=l=] x|

4 C:\PADS Projectstdefault® - PADS Logic

File Edit Wew Setup Tools Help

(] ﬁn% 2 |ﬂ Sheet 1 j &"&I QE‘§ @ J& EE
ke XTI SRBELE YL CEY @RS
[ = | oie[m] o [55] [Bo|  =Ar [ oY | [ 2] | =]

Jadod g poalol4

Kicsi a rajzlap, igy a méretet
és a keretet is érdemes
megnovelni A3-asra.

.[Ad4|< Drawing NumberRevisign>

Ready Width 10 ||Grid 100 6000 3500

Modularamkorok és készulékek 21



Elvi kapcsolasi rajz szerkesztese

4 C:\PADS Projectstdefault® - PADS Logic —|= ﬂ

File Edit Wew Setup Tools Help

D=HS CESY S o Qs BF e B ED
Mts xS #BBRE YLt PEY AR

[l o | e[] o [ (Bl = AT -] [ 2] 2] =

Jadod g poalol4

Width 10 ||Grid 100 5500 S00

Ready

Modularamkorok és készulékek 22



Elvi kapcsolasi rajz szerkesztese

BYDC In

L1

RE
A

D2

o 12¥DC
" out
Q3
a —Cd
BEW %

||+

Wt
24 R7
L RS i

Modularamkorok és készulékek 23



Elvi kapcsolasi rajz szerkesztese

Modularamkorok és készulékek 24



Elvi kapcsolasi rajz szerkesztese

File -> Reports
=L
~ Select Report Files for Output, —— 0k |
Cancel |

[ Unused

[ Part Statistics
[T Met Statistics
™ Limits

Setup... Help

Modularamkorok és készulékek
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Elvi kapcsolasi rajz szerkesztese

x
Attributes I Fu:urmatl Clipboard ‘v’iewl
) Patt Attibute | Field Header | w.aml |
A BOM lista tartalmazza: ﬁ tom pown_|
, ATy Clty
Sorszam REF-DES Reference 10 |
i L PART-TYPE Part Mame 15 E dit
°A|katreSZ aZOHOSItO b anufacturer 1 | kManufacturer 15 4'
Drezcription Drescription a0 ﬂl
*Alkatrész név
Beset |
*Beszerzeés helye
oAr (brutté) k. I Cancel | Help |
Ezen felll minden olyan informaciot szikseges feltuntetni, amelyre az
alkatrészek beszerzése soran szukseg lehet (pl. rendelési kod, stb.)
Modularamkorok és készulékek 26




Elvi kapcsolasi

Ez a rész nem
tartalmaz
fontos
informaciokat,
a tablazat
parameéterei
allithatok be.

rajz szerkesztese

™ Bill of Materials Setup

Aftiibutes  Format | Clipboard ‘v’iewl

" Camma

" Custom I_

— Drelirniter — Format Optionz
= None Report Title:
+ Separatar IBiII Of Materials for &j on &d
" Tab ¥ Combine %alue/Tolerance

[~ Separate Ref. Designataor

Sort By: |Part Name [PART-TYPE]

[

File Format; ITe:-:t File

5 gttings:l

Save Az |

-

j Beset |

[elete |

o ]

Cancel |

Help

Modularamkorok és készulékek
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Elvi kapcsolasi rajz szerkesztese

» Jeloljuk ki a teljes p— .
tablazatot.

 Jeloljuk be az
oszlopnevek
masolasat is.
Masoljuk vagolapra.
OK

Ezt kovetendd, EXCEL-t inditva, majd a tablazatot beillesztve a végleges
valtozat elkészithet6.
Modularamkorok és készulékek 28




BME-ETT, Modularamkorok...

DC-DC konverter

DR AWM : MEPTUM: -
Baolvari Zsaolt abcdle

DR AWIMG M

QUALITY COMTROL:

REELEASED:

Az adatmezOket ugy kell kitolteni, hogy a rajz
késObbi verzidk utan is visszakeresheto legyen!

Modularamkorok és készulékek 29



Elvi kapcsolasi rajz szerkesztese

A rajzlapot célszer( elnevezni, hogy tobb rajzlapon elférd tervek esetéen
is azonosithato legyen!

Setup -> Sheets

I
|
X,

[0l

Mumbered Sheests: Cloze

Nl:|| i amne
1 "DE-DE_KEINVEFETEH

Wi

0

=
=]

D

i

R ename

&dd

[Telete

di

Modularamkorok és készulékek 30



Layout tervezes

N
69 Ztuld
X L
> r
= iRl
T |
gl )=
20
0(% yo sto

o e O o O O

t4)
SHA,
(3]
[FEREEE]
110
e

5]
! P
[k
&
N
ci19 g ©
——m
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Layout tervezes

Egy kis angolszaszsag...

1 mil =0.0254 mm
1TMm=39.37 mil =2 40 mil
1 raszter = 2.54mm=100mil

Modularamkorok és készulékek
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Layout tervezes

Tervezési alapelvek

Tiltott terulet a panel szélétdl 1..2 mm-es sav
Toltsuk ki réezzel a szabad helyeket, igy jobb lesz a zavarvédettseg

Tapvonalak minél vastagabbak, de a jelvezetékek legalabb 2..3x-
osai

Erzékeny alkatrészek vonalait sz{rjik

Nagy fellletekre csatlakozaskor hocsapda alkalmazasa
Sok IC kataldgusaban tippek a NYAK kialakitasara
Erzékeny vezeték (pl. 6rajel) minél révidebb legyen

Egyik oldalon vizszintes, masikon fuggbleges vezetékezés(-re
torekveés)

Egy vezeték 4..5 vianal tobbet ,ne egyen meg”

: n” | |3 reksza n torjon
Vezeték kanyarban” |galabl dergkszdghen rid

33



Layout tervezes

Tervezési alapelvek 2.

Alkatrészek felhelyezése: csatlakozok, massziv alkatrészek, egyéb...
El6szor a tap- és foldvezetékeket kossuk be

Sokszor foldvezetéeket nem kotjuk be, hanem TOP rétegre telifdlia fold
Mér6pontok elhelyezése hasznos lehet

Fontos ugy tervezni, hogy szép legyen, valamint konnyen javithato
Altalaban 12 mil-es jelvezeték, 40 mil-es tap- és féldvezeték

Tap- és fold féslszeri elrendezésben

Err6l vékonyabb vezetékkel agazhatunk le: pl 25 mil

Egy leagazas lehetbleg egy IC-t szolgaljon ki

|IC-k ala érdemes a tap és fold kozé egy 100nF-os szlrdkondit rakni

Alkatrészek lehetbleg egyiranyba alljanak, polaritassal rendelkez6k
f6leg

Modularamkorok és készulékek 34



Layout tervezes

« Setup -> Design Rules
« Default -> Clearance...

x

Hierarchy Uriits

Még mindig Logicban!!!

R EZ 1A |

Drefauilt Clazz Conditional Differential - Feport
Fules Fairz

x

~ Same Net [ Visee tefelly Mirimum  Recommended  Maximum
All Cormer | Wia | |1 i |-| 2 |5|:|
v = Cancel |

| [ e e—
SwWD 12 12
[Nelete
= Trace 12 &l Iracel Yia I Pad I SMD IEQDDETI

Pad 12 Trace |12 Help |

I.-l |..I

:_ ‘ é ‘ Help | Yia |12 12
— Fad |12 12 12

SMD |12 12 12 12

Clearance Routing HiSpeed Repart '

~ Other Text J12 12 12 12
LCopper |12 12 12 12 12 -
Drrill ta Dl Body to Body: Board 12 12 12 12 12 o 2
1 1 Dill f12 12 12 12 12




* VezetOszelesség meretezheto
— Maximalis aramsirisegre
— Kornyezettdl valé maximalis hOmeérseéklet eltérésre

« Alapelv: minél vastagabb vezeto az idealis
— Kis ohmos ellenallas
— Nagy maximalis aramsUriség engedhetd meg
— Sok szo6rt kapacitas
— Nagy helyigény a hordozoén

Gyakorlat: a jelvezetékek szelességéneél a tapvezetekek szélessege
nagyobb, legalabb 2x, 3x.

Modularamkorok és készulékek 36



(A)

v

ARAMEROSSEG

)
-
TOp;+60°C
1
] 70u; - 0°C
P
o "
/ '// A0+ 30°C
f‘/ f‘,/ /r“f
/ ,// ,;/ .{EE}S}JLGO"C
// v AT 700+ 20°C
A A L U U e oc
44V AR 4P E
/ /| AT feT36,: « 30°C
T ven®
A L o T e
e L e
VI | 17 L1
V4% %448Pe
227 dPs
W, a2z
S<dl
a5 1 15 2 25

IViOaQularamkorok es KeszuleKek

Vezetdsav szeélesséq
{rmm}
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/. 1et11111
current

Low frequency High frequency

Modularamkorok és készulékek 38



r

Athallas

Ground

Signal trace

39
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Athallas minimalizalasa

Grounded
— guard
traces

Sigmﬂ trace

Modularamkorok és készulékek 40



Tap es foldvezetek athallasok

Helyes
Analog + Digital +

Analog - Digital - s
Helytelen o, S
Analog + Digital + D7
| -
T T
<—— I
/lf)\/\ Analog - Digi

Modularamkorok és készulékek 41



Digitalis athallas

Nagyimpedancias analdég bemenet k

L
. F

Nagysebesseqgl
digitalis vonal

_ DGND
f [
\

Modularamkorok és készulékek 42



Vezetekezesi struktura

USER USER USER USER USER USER USER USER USER USER USER USER
1 1 1 1 |

Source Source
Single Point Multipoint
USER USER USER
Trace Type

USER USER Power Signal

Single Point Best 0.K.
USER USER Star O.K. Best

Multipoint Worst Worst

Source “Star”

Modularamkorok és készulékek 43



Foldelési pont kialakitasa

Digitalis aramkor Analog aramkor

Aramellatas

Modularamkorok és készulékek 44



Mikroprocesszoros rendszer

ECP88

O

ofolo

I]I]E

Top Side

Bead

ina
EEEEREREREREROERONI
Bl BN W B BN LN B R B BRI

Capacitdrs' |

OSC T 1|1 1irt]

*
L I =

et
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Vezetek kanyarodas

Rossz Jobb Ajanlott
Ey /
Z o -
1W min
—» W €—
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Layout tervezes

™ Default Rules

I.-l |..I

Clearance Raouting HiSpeed Repart

x|

Routing

« Eztitt nem célszeri
beallitani. Sok gyakorlat
kell, hogy mas itt tudjuk,
milyen stratégia szerint
fogunk huzalozni.

Modularamk

" Routing Rules:

— Topology Type
" Protected

&+ Minimized
" Serial Source
i~ Parallel Source

i~ Mid-driven

— Routing Opti
outing Dptions oK

Copper Sharing— ™ Auto Foute

v “ia ¥ Allow Ripup Cancel
v Trace v Allow Shove
r Allow Shove UEIEtE
Protected

b,

Help

Pricrity: |3 :I

— Layer Biazing
Available Layers:

Selected Layers:

B ottam

Top

—Wias

v Use Wias already defined in PCE Layout desigr

Hyailable Wi

Selected Wias

STAMWDARDWA

g [ efinitinnl
Bdd = |
<2 emn:wel

— b axirum number of viaz

™ Unlimited viaz {* kasimum of; IEI

Tip:  The masimurn number
aof wiaz only applies to
autorouting

A7




Layout tervezes

Hi Speed

Olyan tervek esetén
hasznaljak, ahol a
hordozonak
nagyfrekvencias
kovetelményeknek is
meg kell felelnie.

™ Hispeed Rules:

™ Default Rules

I.-l |..I

Clearance Raouting HiSpked

’E ‘ Help |

Repart

— Parallelizm — Rules . ;
Length Gap Mirirurn b aimLm

Barallelism: 1000 |20 Length: fo {50000

T andem: I‘I aa IEEIEI Stub Length: ||:|

™ Aggressor Diglay [ns) jooon  f10.000
—chielding Capacitance [pF): [0.000 {10,000
F Shisld  Gap  [200 Impedance [Ohm}: (50000  {150.000

Use Net: — Matching

I j [T Match Lengths  Tolerance IEEIIII

Modularamkorok és készulékek
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™ Rules

Unitz

Hierarchy

Layout tervezes

.......................

x|

Ze 18

Drefauilt

=il

Clazz

Conditional Differential

Fules

Fairz

Repart

j | Cloze I

Help |

Kijelolni a tap-
es
foldvezetékeket

CTRL+jobbegeér

™ Clearance ND, OUTPUT_12¥A

Rules: +6¥A, AG

R
All Carner Yia |
Via 12

sMD |12 12

$$$24E15 Trace |12

$$$24959 Fad liz

$$$24966

$$424980

$$520019

4425039

$3425054

$$$25056 | ~er

™ ShowN | Drill to Dril: Body to Body:

10 10

- Trace Width Minirurm  Recommended b aximunm
|20 |30 |50

 Clearance

Al | Trace | wia | Pad | sMD | Capper|

Trace |12

Wia |12 12

Fad |12 12 12

SMD 12 12 12 12

Text |12 12 12 12

LCopper |12 12 12 12 12

Board |12 12 12 12 12

Dall 12 12 12 12 12

Ok
Cancel

Delete

Lk,

Help

I.-l |..I
I-'l rI
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E'. pads_labor.asc - Jegyzettomb ;IEIEI

Eail Sgerkesztés Formatum  Mézet  Siga

"Description’ AMPLIFIER MPM SILICOM TRANSISTOR
"Cost"

"Part mumber' BCS47

"Manufacturer #1" MOTOROLA,

"Manufacturer #2"

¥
PART o4

1

"Description’ NPW DARLINGTOMN, 80 WOLTS 40 WATTS
"Cost"

"Part MWumher'" BD&TD

"Manufacturer #1" MOTOROLA

"Manufacturer #2"

¥
PART L1

"sim. analog. model”

"Sim. Analog.order” Model$

"Sim.analog. Prefix” L

"Description” custom dinductor wound with about 30 turns of 0. 5mm magnet wire around a toroidal core with a 1. 40mm
outside diameter

"Cost"

"walue" Custom

"Manufacturer #1"

"Spil Part #"

FART D3

"Description” ZEMER WOLTAGE REGULATOR DIODE, WZ=12V
"Cost"

"Part mMWumher'" BZ=7FOC12

"Manufacturer #1" MOTOROLA

"Manufacturer #2"

¥
¥
HEMD™ OF ASCIT OUTPUT FILE j

-
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[ Untitled - PADS Layout

File Edit ‘Mew 3Setup  Tools  Help

= I | i Top | a8 358 L e Q | &<

Project Explarer * O X

5% Layers
% Components
(21 PCB Decals

Lo Mets

=10l x|

Tools -> PADS
Layout

New
Vissza a
Layout Link
ablakra :
_
DeSIQn Selection  Design l Du:u:ument] Freferences | ECO Names]

Send NET list | Net list
B Project | SendMetlist | v Include Design Bules in Met list

Cubput ind o Compare/ECO : - QX
I Compare Design Bules

E Compats PCB | ECO Ta PCE | ECO From PCE |

Dizconnect | LCloze | Help |

CAPADS Pro

4 4 » ¥ % Status s Macro

Ready W't 10 31100 100 -2500
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LAYOUT-ban!

[ C:\PADS Projects'padsnet* - PADS Layoukt ;Iilﬂ

File Edit Wew Setup Tools Help

= [ | fiH Top v

Project Explorer -nx o

#-£% Layers
= [['j Components

+-d C1

+-k 2

Kt ca

=R

K2 Dz

K2 D3

K2 D4

=N

Bt 1

Bt Q2

4]
4]
4]
4]
4]
]
4]
4]
-k Q3
4]
4]
4]
4]
4]
4]
4]
4]

Bt Q4
Bt R1
Kt Rz
Bt R3
BE R4
Kt RS
Bt Re
Kt R7
+-lk RS
+- 12 PCE Decals

gy Mets

.ﬁproject

Output Window

B x| & LA E

Reading file — C:\PADS Projects\padsnet.asc - version 2007_*
**NO ERRORS FOUND*

— 2
)
M 4 b M wStatus i Macro )

Ready w10 G:100 100 o0 400
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Tools -> Disperse components

[ C:\PADS Projectspadsnet* - PADS Layout =181 x|

¢ File Edt Wiew Setup Tools  Help

=4 =] e IR S-T == =Rt Lo - X 45| i)

Project Explorer -ax g

E-£F Lavers
Elm Components
m-ER C1
= R
e
N =]
=gk D2
E-EE D3
8 =)
=48]
=RE QL
=K§ Q2
=K3 Q3
H-EE Q4
K& R1
Rt Rz
[ ]
E-EE R
H-RE RS
K& e
m-EE R7
=B R
(-1 PCB Decals

(-4 Mets

B Project 14 3

Sutput Window - o x

P DEG R & L
i = =]
Reading file - C:\PADS Projects\padsnet.asc — version 20077
“NO ERRORS FOUND™
-
14 4 » ¥ 4 Status i Macro
Ready [ |10 ll&: 100 100 |[1o000 (/19300
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« Keret rajzolasa

* Drafting Toolbar ->
Board outline.. Blz=:za==

« Célszer( a
rendelkezesre allo
legnagyobb meretet
megadni, majd a
legkisebb felulet
felnasznalasara
torekedni.
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* A feliratok elrendezéséhez a GRID-ek
atallitasa szokott kelleni.

* Erre szukseég lehet, ha finom

raszterosztasu alkatrészekkel (SMD)
dolgozunk.

Modularamkorok és készulékek
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i

[lobal I Dezign | R outing I Thermalz I Dimenzianing I Teardrops I
Dirafting Girids | S plit/Mived Plane I Die Componert I Yia Patterns

Tools -> Options

« Célszerld nem tul kicsit
raszterfinomsagot megadni, ekkor

ugyanis az alkatrészek ,szanaszét” - Design giid et ~Eanout grid
fognak allni, ami esztétikailag és “ O R O
forraszthatésag szempontjabol - E LR N S N P
hatrany, ¥ Snapto gid W Snapto i ¥ Snapto gid
¥ Snap to test point grid
Diizplay grid Hatch arid

b IE':I Copper: |1 1
o IEU Keepaut: I1 oo

Badial kMove Setup... |

| k. I Cancel Apply | Help |
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=

Lev. Twpe Dir. Mame
o | g

2 CM %  Baottom
3 GH Layer_3 .
4 GN  Layerd ﬂl
5 GH Layer &
B GM Laper_& Hel
7 GHM Layer 7 il
g GM Layer_8 ll ..........................
Marne: IT:::p E

[ Component Layer Associakio

Top
— Layer Azzociations

Silkzcreen:

Pazte Maszk:

IF'aste tazk Top j
Solder Maszk:

IS:::Iu:Ier bazk Top j
Azzembly:

I.ﬁ.ssembl_l,l Dirawing Top j

OE.

Cancel

Help

L

~ Electrical Layer Type J—
* Component ™ Routing Azsaciations
Flane Type Routing Direction
* Mo Flare & Horgontal 45
" CaM Plane £ Wertical .45
" SplicMized Ay
— Electrizal Layers
Count: 2 af 20 b adify... Beazzign... | Ihickness...l
— Monelectrical Layers
Count: 28 of 28 Enable/Dizable. .. | b ax I:a_l,lers...l

Modularamkorok és ké:

N | Component Layer Associatio

Biottom
— Layer Azzociations

Silkzcreen:

Pazte Maszk:
IF'aste bl azk Baothom

Le

Solder Maszk:
I Solder Mazk Bottom

Le

Azzembly:

Le

I.ﬁ.ssembl_l,l Drirawing Bottom

OE.

Cancel

Help

L
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Setup -> PAD Stacks...
Belsé réteg rézgylrije mindig
legyen nagyobb, mint a kulsé.

Modularamkoro

[ Pad Stacks Properties - PROBA_YIA

— Pad Stack Type

" Decal &+ Wia

Decal name:

PROBA 1A
STAWDARDWA

addvia |

Cancel

Help

Firr Flated: Bh.: Sz Layer
[ Layerss
CWM 45 <End:
Add Add
[Nelete [Velete
— Parameters
|Jze Global Cefaultz |
FPad style: Ipad j

omoO @

[ Pad size elative ta diill size

Delete Wia |

Darmeter:

o

—Yias
_Iame:

FROBA_VIA

Lizt

il

Lizt Al

Prewview:

0 Throwgh T Partial

Sitart [aper:

¥ | Flated

Crrill size: Ign—j

| =

End/layer:

| =]

- Slat Parameters

[T | Slotted
! =

[Length:

[Mecal nits
i+ il
= Metric

[rientation: I i’

[ffeet: I i’
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« Setup —> Display

[ Display Colors Setup

CO I O rS . s . — Selected Calar Palett |
alette. .
Elllllllll_ll_l_lll_l_| ~
J OO R Default Palette
— Calor I:-y. Layer . Design tems Labels Outlines
Azzign Al | Apply Ta &l EEzts | gz @l 2
o @ i e El. b g Zj o E §- E
Ay Tu:u.-’-'-.IILa_I,Iersl E e R ;IE E u% L% E = l_% % E E E
I~ Wisible anly Wiy VVFINVIVVIFIT VIV IVIV
TiTop "ANEEEN | | REROE S
2Bottom VEEEEERENR ' HERERQR
Slayer_3 EEEAEEEENE HEERER
ALayer_4 AEAEEAEEENR BEERAER
SlLaper_5 vEEEEEEENE EEERER
6L ayer_6 vEEEEEEENE EERERE .
— Other Configuratian
Background . Board Outlime J I j
Selections J Connection J 5 Del
I |
Highlight ] il —
k. I Smply | Cancel | Help |
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Az aktualis,
huzalozasra hasznalt
réteg jeldlve van, —————==5" =
 Huzalozd eszkoz: —
Add Route ikonra—— [
kattintva valik
elérhetove.
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« Csak vastag (>20
mil) vezetékeket
torjunk
derékszogben.

* Ne legyenek
felesleges
,Szakaszok”.

« A PAD-re valo
csatlakozas
lehetbleg
derékszogben
vagy csucsban
tortenjen.
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* File -> CAM
* Add

[ Define CAM Documients

— CAM Documents
Document Mame:

Fabrication Layer:

Surnmary:

Add...
Edit...

[elete

Cloze

.

Save

Help

=]

[T

Bun
Ligtitig |

Cakd Directary: | default

j &perture Bepart...

[mpart...

Export...

il

Frewie
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Setup -> Set Origin -> Igen/Yes

A beultetdgep szamara generalt beulteto file-ok
(Assembly) zerus pontjanak megadasat el kell
végezni!

Helyezzunk le egy ,Moire” nevil alkatrészt a kijelolt
zérus pontra. Igy az
lathato lesz belltetés
soran.

Modularamkorok
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Egy rétegen a korvonal jelolése is szukséges!

[ Add Document

Diocument Hame:

IHaIIgatu:u_munkanev_BElT
Document Type: Clutput File:

| Routing/Split Plane | [art001.pho

Fabrication Layer:

|T|:||:|

Summary:

Raouting/Split Plane: []
Top: [Pads.Wias. Tracks Copper Lines Tey

— Output Device

5| A

Print

s

Phaota

Szzembly Pen

Preview Selections Device Setup..

Tip: Chck Sawe Az Defaultz bo save the curment zettings as

k Save bz Defaultz |
the defaulks for thiz CAM document tepe and output =

bS ke

[ Plot Options - Hallgato_munkaney_BOT

Fef. Dez.: I
™| Exclude Pads

™| Elot Job Hame
[T Plot wWindow

™| Flot OLE Objects
I¥ | Eilled Lines/Fads

OverlUnder)zsize Pads By: ||:|

Cabd Plane Lapers
¥ | Generate T4k Plane Yia Thermalz

™| Use Custam Thermal Settings

Xl
— Pozitioning
Dillymbols.. | [ ok
Orientation: Justification:
IEI j IEIffset j Cancel |
Scaling: # Offzet;
Help
I-I In I-I I-I Lt Frewviem 4'
[ Mimar Image Y Olffzet;
[ Mimar Rief. Des. |1EI|:|
— Other Optionz
Suppress
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Ez az 0sszes, gyartasba adni kivant rétegre el kell végezni!

[ Define CAM Documients

— Cak Documents
Document Mame: Fabrication Layer:

Surnmary:

.

Cloze
Add... Save
Edit...
Delete Help |
=]
[T

Crrill Crrawing: [Board]
Bottom: [Padz Wiaz Lines, Text]
Orrill Drrawing: [Lines, T ext]

Lizting |

CAbd Dhrechany: Idefault j Aperture Report...

[mpart...

Export...

dull

Freswiew

Ha minden réteget beallitottunk: RUN.

Ekkor a megjelolt konyvtarba generalja a GERBER file-okat a

rendszer.
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» A kész Gerber-file-okat a gyartohoz
eljuttatni szukseges.
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